Engineering Analysis with SolidWorks Simulation 2011

Paul M. Kurowski, Ph.D., P.Eng.
Visit the following websites to learn more about this book:
2: Static analysis of a plate

Topics covered

- Using the SolidWorks Simulation interface
- Linear static analysis with solid elements
- Controlling discretization error with the convergence process
- Finding reaction forces
- Presenting FEA results in a desired format

Project description

A steel plate is supported and loaded, as shown in Figure 2-1. We assume that the support is rigid (this is also called built-in support, fixed support or fixed restraint) and that a 100000N tensile load is uniformly distributed along the end face, opposite to the supported face.

Figure 2-1: SolidWorks model of a rectangular plate with a hole

We will perform a displacement and stress analysis using meshes with different element sizes. Note that repetitive analysis with different meshes does not represent standard practice in FEA. The process does however produce results which are useful in gaining more insight into how FEA works.
**Procedure**

In SolidWorks, open the model file called HOLLOW PLATE. Verify that SolidWorks Simulation is selected in the Add-Ins list (Figure 2-2).

![Add-Ins list and SolidWorks SimulationManager tab](image)

Verify that SolidWorks Simulation is selected in the list of Add-Ins (bottom). Once SolidWorks Simulation has been added, Simulation shows in the main SolidWorks tool menu (top).
If the Simulation tab is not showing in the CommandManager, add it by following the steps outlined in Figure 2-3.

Figure 2-3: How to display the Simulation tab in the SolidWorks CommandManager

Right-click any tab in the CommandManager and check “Simulation” from the pop-up menu to make the Simulation tab visible.
Before we create the FEA model, let’s review the **Simulation** main menu (Figure 2-4) along with its **Options** window (Figure 2-5).

**Figure 2-4: Simulation main menu**

*Simulation studies can be executed entirely for this menu. In this book we will mainly use the main menu to access Simulation Options*
The Options window has two tabs. Here, Default Options are shown.

Please spend time reviewing all of the options in both tabs shown in Figure 2-5 before proceeding with the exercise. In the Units options, make the choices shown in Figure 2-5. In this book we will mostly use the SI system of units, and occasionally switch to the IPS system.

Note that Default Plots can be added, deleted or grouped into sub-folders which are created by right-clicking on the Static Study Results folder, Thermal Study Results folder, etc.
Creation of an FEA model starts with the definition of a study. To define a new study, select New Study either from the Simulation menu (Figure 2-4) or the Simulation CommandManager (Figure 2-6). Name the study tensile load 01.

Figure 2-6: Creating a new study

The study definition window offers choices for the types of analysis, here we select Static.
Once a new study has been created, all Simulation Commands can be invoked in three ways:

- From the Simulation main menu (Figure 2-4)
- From the Simulation tab in CommandManager (Figure 2-6)
- By right-clicking appropriate items in the study window

In this book, we will most often use the third method.

When a study is defined, **Simulation** creates a study located below the SolidWorks **FeatureManager** window and places several folders in it. It also adds a study tab that provides access to the study (Figure 2-7).

---

**Figure 2-7: The Simulation window and Simulation tab**

*You can switch between the SolidWorks Model, Motion Studies and Simulation Studies by selecting the appropriate the tab.*
We are now ready to define the analysis model. This process generally consists of the following steps:

- CAD geometry idealization and/or simplification in preparation for analysis. This is usually done in SolidWorks by creating an analysis specific configuration and making your changes there
- Material properties assignment
- Restraints application
- Load application
In this case, the geometry does not need any preparation because it is already very simple, therefore we can start by assigning material properties.

Notice that if a material is defined for a SolidWorks part model, the material definition is automatically transferred to the Simulation model. Assigning a material to the SolidWorks model is actually a preferred modeling technique, especially when working with an assembly consisting of parts with many different materials. We will do this in later exercises.

To apply material to the Simulation model, right-click the HOLLOW PLATE folder in the tensile load 01 simulation study and select **Apply/Edit Material** from the pop-up menu (Figure 2-8).
The action in Figure 2-8 opens the **Material** window shown in Figure 2-9.

![Material window](image)

**Figure 2-9: Material window**

*Select Alloy Steel to be assigned to the model. Click Apply, then click Close.*
In the **Material** window, the properties are highlighted to indicate the mandatory and optional properties. A red description (Elastic modulus, Poisson’s ratio) indicates a property that is mandatory based on the active study type and the material model. A blue description (Mass density, Tensile strength, Compressive strength, Yield strength, Thermal expansion coefficient) indicates optional properties. A black description (Thermal conductivity, Specific heat, Material damping ratio) indicates properties not applicable to the current study.

In the **Material** window, open the **SolidWorks Materials** menu, followed by the **Steel** menu. Select **Alloy Steel**. Select **SI** units under the **Properties** tab (other units could be used as well). Notice that the HOLLOW PLATE folder in the **tensile load 01** study now shows a check mark and the name of the selected material to indicate that a material has been assigned. If needed, you can define your own material by selecting **Custom Defined** material.

Defining a material consists of two steps:

- Material selection (or material definition if a custom material is used)
- Material assignment (either to all solids in the model, selected bodies of a multi-body part, or to selected components of an assembly)
Having assigned the material, we now move to defining the loads and restraints. To display the pop-up menu that lists the options available for defining restraints, right-click the Fixtures folder in the tensile load 01 study (Figure 2-10).

All restraints definitions are done in the Type tab. The Split tab is used to define a split face where a restraint is to be defined. The same can be done in SolidWorks by defining a Split Line.
Once the **Fixtures** definition window is open, select the **Fixed Geometry** restraint type. Select the end-face entity where the restraint is applied.

Note that in SolidWorks **Simulation**, the term “Fixture” implies that the model is firmly “fixed” to the ground. However, aside from **Fixed Geometry**, which we have just used, all other types of fixtures restrain the model in certain directions while allowing movements in other directions. Therefore, the term “restraint” may better describe what happens when choices in the **Fixture** window are made. In this book we will switch between the terms “fixture” and “restraint” freely.
Before proceeding, explore other types of restraints accessible through the **Fixture** window. All types of restraints are divided into two groups: **Standard** and **Advanced**. Review animated examples available in the **Fixture** window and study the following chart.

<table>
<thead>
<tr>
<th>Standard Fixtures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fixed</strong></td>
</tr>
<tr>
<td>Also called built-in, or rigid support. All translational and all rotational degrees of freedom are restrained.</td>
</tr>
<tr>
<td><strong>Immovable (No translations)</strong></td>
</tr>
<tr>
<td>Only translational degrees of freedom are constrained, while rotational degrees of freedom remain unconstrained.</td>
</tr>
<tr>
<td>If solid elements are used (like in this exercise), <strong>Fixed</strong> and <strong>Immovable</strong> restraints would have the same effect because solid elements do not have rotational degrees of freedom. Therefore, the <strong>Immovable</strong> restraint is not available if solid elements are used alone.</td>
</tr>
<tr>
<td><strong>Hinge</strong></td>
</tr>
<tr>
<td>Applies only to cylindrical faces and specifies that the cylindrical face can only rotate about its own axis. This condition is identical to selecting the <strong>On cylindrical face</strong> restraint type and setting the radial and axial components to zero.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Advanced Fixtures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symmetry</strong></td>
</tr>
<tr>
<td>Applies symmetry boundary conditions to a flat face. Translation in the direction normal to the face is restrained and rotations about the axes aligned with the face are restrained.</td>
</tr>
<tr>
<td><strong>Roller/Sliding</strong></td>
</tr>
<tr>
<td>Specifies that a planar face can move freely on its plane but not in the direction normal to its plane. The face can shrink or expand under loading.</td>
</tr>
<tr>
<td><strong>Use reference geometry</strong></td>
</tr>
<tr>
<td>Restrains a face, edge, or vertex only in certain directions, while leaving the other directions free to move. You can specify the desired directions of restraint in relation to the selected reference plane or reference axis.</td>
</tr>
<tr>
<td><strong>On flat face</strong></td>
</tr>
<tr>
<td>Provides restraints in selected directions, which are defined by the three directions of the flat face where restraints are being applied.</td>
</tr>
<tr>
<td><strong>On cylindrical face</strong></td>
</tr>
<tr>
<td>This option is similar to <strong>On flat face</strong>, except that the three directions of a cylindrical face define the directions of restraints.</td>
</tr>
<tr>
<td><strong>On spherical face</strong></td>
</tr>
<tr>
<td>Similar to <strong>On flat face</strong> and <strong>On cylindrical face</strong>. The three directions of a spherical face define the directions of the applied restraints.</td>
</tr>
<tr>
<td><strong>Cyclic symmetry</strong></td>
</tr>
<tr>
<td>Allows analysis of a model with circular patterns around an axis by modeling a representative segment. The segment can be a part or an assembly. The geometry, restraints, and loading conditions must be identical for all other segments making up the model. Turbine, fans, flywheels, and motor rotors can usually be analyzed using cyclic symmetry.</td>
</tr>
</tbody>
</table>
When a model is fully supported (as it is in our case), we say that the model does not have any rigid body motions (the term “rigid body modes” is also used), meaning it cannot move without experiencing deformation.

Note that the presence of restraints in the model is manifested by both the restraint symbols (showing on the restrained face) and by the automatically created icon, Fixture-1, in the Fixtures folder. The display of the restraint symbols can be turned on and off by either:

- Right-clicking the Fixtures folder and selecting Hide All or Show All in the pop-up menu shown in Figure 2-10, or
- Right-clicking the fixture icon and selecting Hide or Show from the pop-up menu.

Use the same method to control display of other symbols.
Now define the load by right-clicking the *External Loads* folder and selecting **Force** from the pop-up menu. This action opens the **Force** window as shown in Figure 2-11.

The **Force** window displays the selected face where the tensile force is applied. If only one entity is selected, there is no distinction between **Per Item** and **Total**. In this illustration, load symbols have been enlarged by adjusting the **Symbols Settings**.

**Figure 2-11:** Pop-up menu for the *External Loads* folder and Force window

The **Force** window displays the selected face where the tensile force is applied. If only one entity is selected, there is no distinction between **Per Item** and **Total**. In this illustration, load symbols have been enlarged by adjusting the **Symbols Settings**.
In the **Type** tab, select **Normal** in order to load the model with a 100000N tensile force uniformly distributed over the end face, as shown in Figure 2-11. Check the **Reverse direction** option to apply a tensile load.

Generally, forces can be applied to faces, edges, and vertices using different methods, which are reviewed below:

<table>
<thead>
<tr>
<th>Force normal</th>
<th>Available for flat faces only, this option applies load in the direction normal to the selected face.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Force selected direction</strong></td>
<td>This option applies a force or a moment to a face, edge, or vertex in the direction defined by the selected reference geometry.</td>
</tr>
<tr>
<td></td>
<td>Moments can be applied only if shell elements are used. Shell elements have six degrees of freedom per node: three translations and three rotations, and can take a moment load.</td>
</tr>
<tr>
<td></td>
<td>Solid elements only have three degrees of freedom (translations) per node and, therefore, cannot take a moment load directly.</td>
</tr>
<tr>
<td></td>
<td>If you need to apply moments to solid elements, they must be represented with appropriately applied forces.</td>
</tr>
<tr>
<td><strong>Torque</strong></td>
<td>This option applies torque (expressed by traction forces) about a reference axis using the right-hand rule.</td>
</tr>
</tbody>
</table>

Try using the click-inside technique to rename the **Fixture-1** and **Force/Torque-1** icons. Note that renaming using the click-inside technique works on all icons in SolidWorks **Simulation**.

The model is now ready for meshing. Before creating a mesh, let’s make a few observations about defining the geometry, material properties, loads and restraints.

Geometry preparation is a well-defined step with few uncertainties. Geometry that is simplified for analysis can be compared with the original CAD model.

Material properties are most often selected from the material library and do not account for local defects, surface conditions, etc. Therefore, the definition of material properties usually has more uncertainties than geometry preparation.

The definition of loads is done in a few quick menu selections, but involves many assumptions. Factors such as load magnitude and distribution are often only approximately known and must be assumed. Therefore, significant idealization errors can be made when defining loads.
Defining restraints is where severe errors are most often made. For example, it is easy enough to apply a fixed restraint without giving too much thought to the fact that a fixed restraint means a rigid support – a mathematical abstraction. A common error is over-constraining the model, which results in an overly stiff structure that underestimates displacements and stresses. The relative level of uncertainties in defining geometry, material, loads, and restraints is qualitatively shown in Figure 2-12.

![Figure 2-12: Qualitative comparison of uncertainty in defining geometry, material properties, loads, and restraints](image)

The level of uncertainty (or the risk of error) has no relation to time required for each step, so the message in Figure 2-12 may be counterintuitive. In fact, preparing CAD geometry for FEA may take hours, while applying restraints and loads takes only a few clicks.
In all of the examples presented in this book, we assume that definitions of material properties, loads, and restraints represent an acceptable idealization of real conditions. However, we need to point out that it is the responsibility of the FEA user to determine if all those idealized assumptions made during the creation of the mathematical model are indeed acceptable.

Before meshing the model, we need to verify under the Default Options tab, in the Mesh properties, that High mesh quality is selected (Figure 2-13). The Options window can be opened from the SolidWorks Simulation menu as shown in Figure 2-4.

![Default Options - Mesh](image)

**Figure 2-13: Mesh settings in the Options window**

Use this window to verify that the mesh quality is set to High and the mesh type is set to Standard. Use these settings for other exercises unless indicated otherwise.
The difference between **High** and **Draft** mesh quality is:

- Draft quality mesh uses first order elements
- High quality mesh uses second order elements

Differences between first and second order elements were discussed in chapter 1.

The difference between **Curvature based** mesh and **Standard** mesh will be explained in chapter 3. **Curvature** based mesh is the default in **Simulation**. However, **Standard** mesh will be used throughout this book because this offers a better insight into mesh quality problems. This is done to enhance the learning experience of the reader. **Curvature based** meshes will be used rarely and will be pointed out.

Now, right-click the **Mesh** folder to display the pop-up menu (Figure 2-14).

![Mesh pop-up menu](image)

**Figure 2-14: Mesh pop-up menu**

In the pop-up menu, select **Create Mesh**. This opens the **Mesh** window (Figure 2-15) which offers a choice of element size and element size tolerance.

This exercise reinforces the impact of mesh size on results. Therefore, we will solve the same problem using three different meshes: coarse, medium (default), and fine. Figure 2-15 shows the respective selection of meshing parameters to create the three meshes.
Select Mesh Parameters to see the element size. In all three cases use Standard mesh. Note the different slider positions in the three windows. Verify that standard mesh is used.

The medium mesh density, shown in the middle window in Figure 2-15, is the default that SolidWorks Simulation proposes for meshing our model. The element size of 5.72 mm and the element size tolerance of 0.286 mm are established automatically based on the geometric features of the SolidWorks model. The 5.72 mm size is the characteristic element size in the mesh, as explained in Figure 2-16. The default tolerance is 5% of the global element size. If the distance between two nodes is smaller than this value, the nodes are merged unless otherwise specified by contact conditions (contact conditions are not present in this model).

Mesh density has a direct impact on the accuracy of results. The smaller the elements, the lower the discretization error, but the meshing and solving time both take longer. In the majority of analyses with SolidWorks Simulation, the default mesh settings produce meshes that provide acceptable discretization errors, while keeping solution times reasonably short.
The characteristic element size of a tetrahedral element is the diameter \( h \) of a circumscribed sphere (left). This is easier to illustrate with the 2D analogy of a circle circumscribed on a triangle (right).

Right-click the Mesh folder again and select **Create…** to open the Mesh window.

With the Mesh window open, set the slider all the way to the left (as illustrated in Figure 2-15, left) to create a coarse mesh, and click the green checkmark button. The mesh will be displayed as shown in Figure 2-17.

**Figure 2-16: Characteristic element size for a tetrahedral element**

**Figure 2-17: A coarse mesh created with second order, solid tetrahedral elements**

You can control the mesh visibility by selecting Hide Mesh or Show Mesh from the pop-up menu shown in Figure 2-14.
The presence of a mesh is reflected in the appearance of the solid icon in a Simulation study (Figure 2-18).

![Solid icon in a Simulation study before and after meshing](Image)

**Figure 2-18: Solid icon in a Simulation study before and after meshing**

*Cross hatching is added to the Solid icon in a Simulation study to show that a mesh has been created.*

To start the solution, right-click the **tensile load 01** study folder which displays a pop-up menu (Figure 2-19). Select **Run** to start the solution.

![Pop-up menu for the tensile load 01 folder](Image)

**Figure 2-19: Pop-up menu for the tensile load 01 folder**

*Start the solution by right-clicking the tensile load 01 folder to display a pop-up menu. Select Run to start the solution.*

The solution can be executed with different properties, which we will investigate in later chapters. You can monitor the solution progress while the solution is running (Figure 2-20).
Figure 2-20: Solution Progress window

The solver reports solution progress while the solution is running.

If the solution fails, the failure is reported as shown in Figure 2-21.

Figure 2-21: Failed solution warning window

Here, the solution of a model with no restraints was attempted. Once the error message has been acknowledged (top), the solver displays the final outcome of the solution (bottom).
When the solution completes successfully, **Simulation** creates a *Results* folder with result plots which are defined in **Simulation Default Options** as shown in Figure 2-5.

In a typical configuration three plots are created automatically in the Static study:

- **Stress1** showing von Mises stresses
- **Displacement1** showing resultant displacements
- **Strain1** showing equivalent strain

Make sure that the above plots are defined in your configuration, if not, define them.

Once the solution completes, you can add more plots to the *Results* folder. You can also create subfolders in the *Results* folder to group plots (Figure 2-22).

![Figure 2-22: More plots and folders can be added to the Results folder](image)

*Right-clicking on the Results folder activates this pop-up menu from which plots may be added.*
To display stress results, double-click on the **Stress1** icon in the **Results** folder or right-click it and select **Show** from the pop-up menu. The stress plot is shown in Figure 2-23.

**Figure 2-23: Stress plot displayed using default stress plot settings**

*Von Mises stress results are shown by default in the stress plot window. Notice that results are shown in [MPa] as was set in the Default Options tab (Figure 2-5). The highest stress 345 MPa is below the material yield strength, 620 MPa. The actual numerical results may differ slightly depending on the solver used, software version, and service pack used.*
Once the stress plot is showing, right-click the stress plot icon to display the pop-up menu featuring different plot display options (Figure 2-23).

Figure 2-24: Pop-up menu with plot display options

Any plot can be modified using selections from the pop-up menu (top). Callouts relate selections in the pop-up menu to the invoked windows. Explore all selections offered by these three windows. In particular, explore color Options accessible from Chart Options, not shown in the above illustration.
Chart Options offers control over the format of numerical results, such as scientific, floating, and general, and also offers a different number of decimal places. Explore these choices. In this book, results will be presented using different choices, most suitable for the desired plot.

The default type of Fringe Options in the Settings window is Continuous (Figure 2-24). Change this to Discrete through the Default Options window, by selecting Plot (Figure 2-5). This way you won’t have to modify the future plots individually. In this book we’ll be using Discrete Fringe Options to display fringe plots. The plots from the current study will not change after changing the default options.

Since the above change does not affect already existing plots, we now examine how to modify the stress plot using the Settings window shown in Figure 2-25. In Settings, select Discrete in Fringe options and Mesh in Boundary options to produce the stress plot shown in Figure 2-25.

The stress plot in Figure 2-25 shows node values, also called averaged stresses. Element values (or non-averaged stresses) can be displayed by proper selection in the Stress Plot window in Advanced Options. Node values are most often used to present stress results. See chapter 3 and the glossary of terms in chapter 23 for more information on node values and element values of stress results.
Before you proceed, investigate this stress plot with other selections available in the windows shown in Figure 2-24.

We now review the displacement and strain results. All of these plots are created and modified in the same way. Sample results are shown in Figure 2-26 (displacement) and Figure 2-27 (strain).

Figure 2-26: Displacement plot (left) and Deformation plot (right)

*A Displacement plot can be turned into a Deformation plot by deselecting Show Colors in the Displacement Plot window. The same window has the option of showing the model with an exaggerated scale of deformation as shown above.*
The plots in Figures 2-23, 2-25, 2-26, 2-27 all show the deformed shape in an exaggerated scale. You can change the display from deformed to undeformed or modify the scale of deformation in the Displacement Plot, Stress Plot, and Strain Plot windows, activated by right-clicking the plot icon, then selecting Edit Definition.

Now, construct a Factor of Safety plot using the menu shown in Figure 2-22. The definition of the Factor of Safety plot requires three steps. Follow steps 1 to 3 using the selection shown in Figure 2-28. Review Help to learn about failure criteria and their applicability to different materials.

Figure 2-27: Strain results

Strain results are shown here using Element values. The mesh is not shown.
Figure 2-28: Three windows show the three steps in the Factor of Safety plot definition. Select the Max von Mises Stress criterion in the first window.

To move through steps, click on the right and left arrows located at the top of the Factor of Safety dialog.

Step 1 selects the failure criterion, step 2 selects display units and sets the stress limit, step 3 selects what will be displayed in the plot. Here we select areas below the factor of safety 2.
The factor of safety plot in Figure 2-29 shows the area where the factor of safety is below the specified.

![Figure 2-29: The red color (shown as white in this grayscale illustration) displays the areas where the factor of safety falls below 2](image)

We have completed the analysis with a coarse mesh and now wish to see how a change in mesh density will affect the results. Therefore, we will repeat the analysis two more times using medium and fine density meshes respectively. We will use the settings shown in Figure 2-15. All three meshes used in this exercise (coarse, medium, and fine) are shown in Figure 2-30.

![Figure 2-30: Coarse, medium, and fine meshes](image)

*Three meshes used to study the effects of mesh density on results.*
To compare the results produced by different meshes, we need more information than is available in the plots. Along with the maximum displacement and the maximum von Mises stress, for each study we need to know:

- The number of nodes in the mesh.
- The number of elements in the mesh.
- The number of degrees of freedom in the model.

The information on the number of nodes and number of elements can be found in Mesh Details accessible from the menu in Figure 2-14. The mesh Details window is shown in Figure 2-31.

![Mesh Details window](image)

Figure 2-31: Mesh details window

*Right-click the Mesh folder and select Details from the pop-up menu to display the Mesh Details window. Note that information on the number of degrees of freedom is not available here. Make sure you are comfortable with all the terms used in this window.*
The most convenient way to find the number of nodes, elements and degrees of freedom is to use the pop-up menu shown in Figure 2-22. Select **Solver Messages** to display the window shown in Figure 2-32.

![Solver Message window](image)

*Figure 2-32: The Solver Message window lists information pertaining to the solved study*

*To save this solver message, click the Save button.*

Now create and run two more studies: *tensile load 02* with the default element size (medium), and *tensile load 03* with a fine element size, as shown in Figure 2-15. To create a new study we could just repeat the same steps as before but an easier way is to copy the original study. To copy a study, follow the steps in Figure 2-33.
Figure 2-33: A study can be copied into another study in three steps as shown.

Note that all definitions in a study (material, restraints, loads, mesh) can also be copied individually from one study to another by dragging and dropping them into a different study tab.

A study is copied complete with results and plot definitions. Before remeshing, you must acknowledge the warning message shown in Figure 2-34.

Figure 2-34: Remeshing deletes any existing results in the study.
The summary of results produced by the three studies is shown in Figure 2-35.

<table>
<thead>
<tr>
<th>Study</th>
<th>Element size [mm]</th>
<th>Max. resultant displacement [mm]</th>
<th>Max. von Mises stress [MPa]</th>
<th>Number of elements</th>
<th>Number of nodes</th>
<th>Number of DOF</th>
</tr>
</thead>
<tbody>
<tr>
<td>tensile load 01</td>
<td>11.45</td>
<td>0.1178</td>
<td>345</td>
<td>2820</td>
<td>1510</td>
<td>8289</td>
</tr>
<tr>
<td>tensile load 02</td>
<td>5.72</td>
<td>0.1180</td>
<td>372</td>
<td>12204</td>
<td>7024</td>
<td>36057</td>
</tr>
<tr>
<td>tensile load 03</td>
<td>2.86</td>
<td>0.1181</td>
<td>378</td>
<td>84427</td>
<td>55222</td>
<td>251796</td>
</tr>
</tbody>
</table>

Figure 2-35: Summary of results produced by the three meshes

Note that these results are based on the same problem. Differences in the results arise from the different mesh densities used in studies tensile load 01, tensile load 02, and tensile load 03.

The actual numbers in this table may vary slightly depending on the type of solver and release of the software used for solution.

Figure 2-36 shows the maximum resultant displacement and the maximum von Mises stress as a function of the number of degrees of freedom. The number of degrees of freedom is in turn a function of mesh density.

Figure 2-36: Maximum resultant displacement (left) and maximum von Mises stress (right)

Both are plotted as a function of the number of degrees of freedom in the model. The three points on the curves correspond to the three models solved. Straight lines connect the three points only to visually enhance the graphs.
Having noticed that the maximum displacement increases with mesh refinement, we can conclude that the model becomes “softer” when smaller elements are used. With mesh refinement, a larger number of elements allows for better approximation of the real displacement and stress field. Therefore, we can say that the artificial constraints imposed by element definition become less imposing with mesh refinement.

Displacements are the primary unknowns in structural FEA, and stresses are calculated based on displacement results. Therefore, stresses also increase with mesh refinement. If we continued with mesh refinement, we would see that both the displacement and stress results converge to a finite value which is the solution of the mathematical model. Differences between the solution of the FEA model and the mathematical model are due to discretization errors, which diminish with mesh refinement.

We will now repeat our analysis of the HOLLOW PLATE by using prescribed displacements in place of a load. Rather than loading it with a 100000N force that caused a 0.118 mm displacement of the loaded face, we will apply a prescribed displacement of 0.118 mm to this face to see what stresses this causes. For this exercise, we will use only one mesh with the default (medium) mesh density.
Define a fourth study, called *prescribed displ*. The easiest way to do this is to copy study *tensile load 02*. The definition of material properties, the fixed restraint to the left-side end-face and mesh are all identical to the previous design study. We need to delete the load (right-click the load icon and select **Delete**) and apply in its place a prescribed displacement.

To apply the prescribed displacement to the right-side end-face, create a new **Fixed Geometry** by right-clicking the **Fixtures** folder and selecting **Advanced Fixtures** from the pop-up menu. This opens the **Fixture** definition window. Select **On Flat Face** from the **Advanced** menu and define the displacement as shown in Figure 2-37. Check **Reverse direction** to obtain displacement in the tensile direction. Note that the direction of a prescribed displacement is indicated by a restraint symbol.

![Figure 2-37: Restraint definition window](image)

The prescribed displacement of 0.118 mm is applied to the same face where the tensile load of 100000N had been applied. Select Reverse Direction and make sure that the arrows are pointed out.

The size and color of arrows can be changed using Symbol Settings. The color and size of all load and restraint symbols is controlled the same way.
The visibility of all load and restraints symbols is controlled by right-clicking the symbol and making the desired choice (Hide/Show). All load symbols and all restraint (fixture) symbols may also be turned on/off all at once by right-clicking Fixtures or External loads folders and selecting Hide all/Show all from the pop-up menu.

Once a prescribed displacement is defined to the end face, it overrides any previously applied loads to the same end face. While it is better to delete the load in order to keep the model clean, the load has no effect if a prescribed displacement is applied to the same entity in the same direction.

Figures 2-38 compares stress results for the model loaded with force to the model loaded with prescribed displacement.

Figure 2-38: Comparison of von Mises stress results

*Von Mises stress results with a load applied as a force are displayed on the left and von Mises stress results with a load applied as a prescribed displacement are displayed on the right.*
Results produced by applying a force load and by applying a prescribed displacement load are very similar, but not identical. The reason for this discrepancy is that in the model loaded by force, the loaded face is allowed to deform. In the prescribed displacement model, this face remains flat, even though it experiences displacement as a whole. Also, while the prescribed displacement of 0.118 mm applies to the entire face in the prescribed displacement model, it is only seen as a maximum displacement in one point in the force load model. You may plot the displacement along the edge of the end face in study tensile load 02 by following the steps in Figure 2-39.
Right-click the resultant displacement plot in the tensile load 02 study to invoke a pop-up menu shown in the top left corner. Follow steps 1 through 4 to produce a graph of displacements along the loaded edge. Repeat this exercise for a model loaded with a prescribed displacement to verify that the displacement is constant along the edge.
We conclude the analysis of the HOLLOW PLATE by examining the reaction forces using the results of study tensile load 02. In the study tensile load 02, right-click the Results folder. From the pop-up menu, select List Result Force to open the Result Force window. Select the face where the fixed restraint is applied and click the Update button. Information on reaction forces will be displayed as shown in Figure 2-40.

![Diagram of the Result Force window](image)

**Figure 2-40: Result Force window**

Right-click the Results folder and follow steps 1 through 4 to analyze and display reaction forces. Reaction forces can also be displayed in components other than those defined by the global reference system. To do this, reference geometry such as a plane or axis must be selected.
A note on where **Simulation** results are stored: By default, all study files are saved in the same folder with the SolidWorks part or assembly model. Mesh data and results of each study are stored separately in *.CWR files. For example, the mesh and results of study *tensile load 02* have been stored in the file:

HOLLOW PLATE-tensile load 02.CWR.

When the study is opened, the CWR file is loaded into a number of different files depending on the type of study. Upon exiting SolidWorks **Simulation** (which is done by means of deselecting SolidWorks **Simulation** from the list of add-ins, or by closing the SolidWorks model), all files are compressed allowing for convenient backup of SolidWorks **Simulation** results.

The location of CWR files is specified in the **Default Options** window (Figure 2-5). For easy reference, the **Default Options** window is shown again in Figure 2-41.

![Default Options - Results](image)

**Figure 2-41: Location of solution database files**

*Using these settings, CWR files are located in the SolidWorks document folder.*